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Revision History 
 

Version Date Description 

1.0 2018-09-05 Initial Release 

1.1 2021-01-21 

 Revised the Quantum Efficiency graph 

 Revised the model name 

 Revised camera mechanical dimensions 

1.2 
2021-05-12 Corrected the orientation of the 4-pin connector in the user manual 

2021-09-24 Deleted the “Exposure Control” text in the “Main Features” 
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1 Precautions 

General 

 

 Do not drop, disassemble, repair or alter the device. Doing so may damage the camera 

electronics and cause an electric shock. 

 Do not let children touch the device without supervision. 

 Stop using the device and contact the nearest dealer or manufacturer for technical 

assistance if liquid such as water, drinks or chemicals gets into the device. 

 Do not touch the device with wet hands. Doing so may cause an electric shock. 

 Make sure that the temperature of the camera does not exceed the temperature range 

specified in 5.2 Specifications. Otherwise the device may be damaged by extreme 

temperatures. 

 

Installation and Maintenance 

 

 Do not install in dusty or dirty areas – or near an air conditioner or heater to reduce the 

risk of damage to the device. 

 Avoid installing and operating in an extreme environment where vibration, heat, humidity, 

dust, strong magnetic fields, explosive/corrosive mists or gases are present. 

 Do not apply excessive vibration and shock to the device. This may damage the device. 

 Avoid direct exposure to a high intensity light source. This may damage the image sensor. 

 Do not install the device under unstable lighting conditions. Severe lighting change will 

affect the quality of the image produced by the device. 

 Do not use solvents or thinners to clean the surface of the device. This can damage the 

surface finish. 

 

Power Supply 

 

 Applying incorrect power can damage the camera. If the voltage applied to the camera is 

greater or less than the camera’s nominal voltage, the camera may be damaged or 

operate erratically. Please refer to 5.2 Specifications for the camera’s nominal voltage. 

※ Vieworks Co., Ltd. does NOT provide power supplies with the devices. 

 Make sure the power is turned off before connecting the power cord to the camera. 

Otherwise damage to the camera may result. 
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Cleaning the Sensor Surface 

Avoid cleaning the surface of the camera’s sensor if possible. If you have dust or foreign matter on the sensor 

surface, use a soft lint free cotton bud dampened with a small quantity of high quality lens cleaner. Because 

electrostatic discharge (ESD) can damage the sensor, you must use a cloth (e.g. cotton) that will not generate 

static during cleaning. 

 

 

Avoid dust or foreign matter on the sensor surface. 

The camera is shipped with a protective plastic seal on the camera front. To prevent collecting 

dust or foreign matter on the camera sensor, make sure that you always put the protective seal 

in place when there is no lens mounted on the camera. In addition, make sure to always point 

the camera downward when there is no protective seal on the camera front or no lens 

mounted. 

 

Procedures for Cleaning the Sensor 

If you have dust or foreign matter on the sensor surface, follow the procedures below to wipe off. 

1. Remove a contaminant by using an ionizing air gun. 

 If this step does not remove the contaminant, proceed to the next step. 

2. Clean the contaminant on the sensor using one drop of lens cleaner on a non-fluffy cotton bud. 

3. Wipe the cotton bud gently in only one direction (either left to right or right to left). Avoid wiping back and 

forth with the same cotton bud in order to ensure that the contaminants are removed and not simply 

transferred to a new location on the sensor surface. 

4. Mount a lens, set the lens at a smaller aperture (e.g. F8), and then acquire images under bright lighting 

conditions. Check the images on the monitor for dark spots or stripes caused by the contaminant. Repeat 

the steps above until there is no contaminant present. 

 

 

If the sensor is damaged due to electrostatic discharge or the sensor surface is scratched 

during cleaning, the warranty is void. 
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2 Warranty 

Do not open the housing of the camera. The warranty becomes void if the housing is opened. 

For information about the warranty, please contact your local dealer or factory representative. 

 

3 Compliance & Certifications 

3.1 FCC Compliance 

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 

15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference 

when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate 

radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause 

harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause 

harmful interference in which case the user will be required to correct the interference at his own expenses. 

 

3.2 CE: DoC 

EMC Directive 2014/30/EU 

EN 55032:2012 (Class A), EN 55024:2010 

Class A 

 

3.3 KC 

KCC Statement 

 

Type Description 

Class A 

(Broadcasting Communication 

Device for Office Use) 

This device obtained EMC registration for office use (Class A), and may 

be used in places other than home. Sellers and/or users need to take 

note of this. 
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4 Package Components 

 

Package Components 

 

 

 

VTC-2K10.5C-C100A-80 Camera with M42 mount 
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5 Product Specifications 

5.1 Overview 

The VTC-2K10.5C camera, a hybrid Time Delayed Integration (TDI) color line scan camera, provides faster line 

rates and higher sensitivity than existing line scan cameras. With hybrid TDI line scan technology combining the 

strengths of both CCD and CMOS image sensors, the M42 mount based VTC-2K10.5C-C100A-80 camera can 

acquire True Color images at faster line rates of up to 100 ㎑ with up to 80 higher sensitivity. 

Featured with high speed and high sensitivity, the VTC-2K10.5C camera is ideal for demanding applications 

such as flat panel display inspection, wafer inspection, printed circuit board inspection, and high performance 

document scanning. 

 

Main Features 
 Hybrid TDI Color Line Scan 

 True Color Imaging 

 2160  80 Pixel Resolution 

 Bidirectional Operations with up to 80 TDI Stages 

 Anti-blooming 

 Trigger Rescaler and Strobe Output Control 

 Camera Link Full Interface up to 100 ㎑ 

 Advanced PRNU and DSNU Correction 

 Area Scan Mode for Camera Alignment 

 

Applications 
 Flat Panel Display Inspection 

 Printed Circuit Board Inspection 

 Wafer Inspection 

 High Performance Document Scanning 
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5.2 Specifications 

Technical specifications for the VTC-2K10.5C camera are as follows: 
 

Specification VTC-2K10.5C-C100A-80 

Active Image(H × V) 2160 × 80 

Sensor Type Hybrid TDI Color Line Scan 

Pixel Size 10.5 ㎛ × 10.5 ㎛ 

Interface Camera Link (Base/Medium/Full) 

Pixel Data Format 8 bit (2/3/4/8/10 Tap) /10 bit (2/4 Tap) / 12 bit (2/4 Tap) 

TDI Stage 20 / 40 / 60 / 80 

TDI Direction External Control Port or Programmable 

Trigger Synchronization 
Free-Run, External Trigger Signal, Camera Link CC1 

Programmable Line Rate 

Max. Line Rate 100 ㎑ 

Min. Line Rate 1 ㎑ 

Camera Link Pixel Clock 40 / 60 / 80 / 85 ㎒ 

Video Output 2, 3, 4, 8 or 10 Tap 

Throughput 0.22 Gpix/s 

Gamma Correction User Defined LUT (Look Up Table) 

Black Level -255 ~ 255 at 8 bits 

Gain Control Analog Gain: 1×, 2×, 3×, 4× / Digital Gain: 1.0× ~ 8.0× 

External Trigger External, 3.3 V – 5.0 V 

Power 
External 10 ~ 30 V DC 

Dissipation Typ. 5.0 W 

Environmental Ambient Operating: 0℃ ~ 50℃ (Housing: 10℃ ~ 50℃), Storage: -40℃ ~ 70℃ 

Mechanical / Weight 60 ㎜ × 60 ㎜ × 36 ㎜, 223 g 

Configuration Software Configurator 

Optical Interface 

Lens Mount M42 × 1 ㎜ 

Sensor to Camera Front 10.10 ㎜ (Optical Distance) 

Sensor Alignment 

Flatness 

x 

y 

z 

±25 ㎛ 

±0.15 ㎜ 

±0.15 ㎜ 

±0.1 ㎜ 

Table 5.1  Specifications of the VTC-2K10.5C camera  
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5.3 Camera Block Diagram 

The VTC-2K10.5C camera consists of three printed circuit boards (PCB), and its block diagram is shown below. 

 

 

Figure 5.1  VTC-2K10.5C-C100A-80 Camera Block Diagram 
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5.4 Spectral Response 

The following graphs show the spectral response for the VTC-2K10.5C camera. 

 

 

Figure 5.2  Quantum Efficiency 
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5.5 Mechanical Specification 

The camera dimensions in millimeters are shown in the following figure. 

 

 

Figure 5.3  VTC-2K10.5C Mechanical Dimension 

 

5.5.1 Camera Mounting and Heat Dissipation 

You must mount the camera on a heat dissipation structure to maintain the temperature of the camera housing 

at 50℃ or less. Given the low power consumption of the VTC camera, its housing temperature during operation 

will generally stay within the specified limits. However, overheating can occur if heat dissipation is restricted or if 

the camera is mounted on a severe environment. We strongly recommend that you follow the general guidelines 

below when you mount the camera. 

 In all cases, you should monitor the temperature of the camera housing and make sure that the temperature 

does not exceed 50℃. You can monitor the internal temperature of the camera by using the Device 

Temperature parameter. 

 If your camera is mounted on a metal component in your system, this may provide sufficient heat 

dissipation. 
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6 Connecting the Camera 

The following instructions assume that you have installed a Camera Link frame grabber in your computer 

including related software. For more information, refer to your Camera Link frame grabber user manual. 

To connect the camera to your computer, follow the steps below. 

 

1. Make sure that the power supply is not connected to the camera and your computer is turned off. 

2. Plug one end of a Camera Link cable into the Camera Link1 connector on the camera and the other end of 

the Camera Link cable into the Base connector on the Camera Link frame grabber. 

3. Plug one end of a Camera Link cable into the Camera Link2 connector on the camera and the other end of 

the Camera Link cable into the Medium/Full connector on the Camera Link frame grabber. 

4. Connect the plug of the power adapter to the power input receptacle on the camera. 

5. Plug the power adapter into a working electrical outlet. 

6. Verify all the cable connections are secure. 

 

Precautions for using Camera Link Medium/Full Configuration 

 

 

The VTC-2K10.5C camera supports Camera Link Base, Medium and Full configurations. 

To operate the camera in the medium or full Camera Link configuration, you must connect the 

camera to the Camera Link frame grabber using two Camera Link cables. Make sure that you 

connect both Camera Link1 (Base) and Camera Link2 (Medium/Full) connectors on the 

camera to their respective connectors on the Camera Link frame grabber. 

 

6.1 Precaution to Center the Image Sensor 

 Users do not need to center the image sensor as it is adjusted as factory default settings. 

 When you need to adjust the center of the image sensor, please contact your local dealer or the 

manufacturer for technical assistance. 

 

6.2 Controlling the Camera 

 You can control the camera by using Configurator. 

 You can download the latest Configurator at http://www.vieworks.com. 

 Please refer to your Camera Link frame grabber user manual.  

http://www.vieworks.com/eng/IISoftware.html
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7 Camera Interface 

7.1 General Description 

As shown in the figure below, 3 types of connectors and a status indicator LED are located on the back of the 

camera and have the functions as follows: 

 

 ① 26 pin SDR Connector 1 (Camera Link Base): transmits video data and controls the camera. 

 ② 26 pin SDR Connector 2 (Camera Link Medium/Full): transmits video data. 

 ③ Status LED: displays power status and operation mode. 

 ④ 6 pin Power Input Receptacle: supplies power to the camera. 

 ⑤ 4 pin Control I/O Receptacle: provides access to the camera’s I/O lines. 

 

 

Figure 7.1  VTC-2K10.5C Back Panel 

 

7.2 Camera Link SDR Connector 

 

 

Figure 7.2  Camera Link SDR Connector  
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Camera Link connectors comply with Camera Link Standard and the following list shows the pin assignments of 

the connector. 

 

PAIR List Pin Signal Name Type Description 

PAIR 0 
1 Ground Ground Cable Shield 

14 Ground Ground Cable Shield 

PAIR 1 
2 -X0 LVDS - Out Camera Link Transmitter 

15 +X0 LVDS - Out Camera Link Transmitter 

PAIR 2 
3 -X1 LVDS - Out Camera Link Transmitter 

16 +X1 LVDS - Out Camera Link Transmitter 

PAIR 3 
4 -X2 LVDS - Out Camera Link Transmitter 

17 +X2 LVDS - Out Camera Link Transmitter 

PAIR 4 
5 -XCLK LVDS - Out Camera Link Transmitter 

18 +XCLK LVDS - Out Camera Link Transmitter 

PAIR 5 
6 -X3 LVDS - Out Camera Link Transmitter 

19 +X3 LVDS - Out Camera Link Transmitter 

PAIR 6 
7 + SerTC LVDS - In Serial Data Receiver 

20 - SerTC LVDS - In Serial Data Receiver 

PAIR 7 
8 - SerTFG LVDS - Out Serial Data Transmitter 

21 + SerTFG LVDS - Out Serial Data Transmitter 

PAIR 8 
9 - CC 1 LVDS - In Software External Trigger 

22 + CC 1 LVDS - In Software External Trigger 

PAIR 9 
10 N/C N/C N/C 

23 N/C N/C N/C 

PAIR 10 
11 N/C N/C N/C 

24 N/C N/C N/C 

PAIR 11 
12 N/C N/C N/C 

25 N/C N/C N/C 

PAIR 12 
13 Ground Ground Cable Shield 

26 Ground Ground Cable Shield 

Table 7.1  Pin Assignments for Camera Link Connector 1 
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PAIR List Pin Signal Name Type Description 

PAIR 0 
1 Ground Ground Cable Shield 

14 Ground Ground Cable Shield 

PAIR 1 
2 -Y0 LVDS - Out Camera Link Transmitter 

15 +Y0 LVDS - Out Camera Link Transmitter 

PAIR 2 
3 -Y1 LVDS - Out Camera Link Transmitter 

16 +Y1 LVDS - Out Camera Link Transmitter 

PAIR 3 
4 -Y2 LVDS - Out Camera Link Transmitter 

17 +Y2 LVDS - Out Camera Link Transmitter 

PAIR 4 
5 -YCLK LVDS - Out Camera Link Transmitter 

18 +YCLK LVDS - Out Camera Link Clock Tx 

PAIR 5 
6 -Y3 LVDS - Out Camera Link Channel Tx 

19 +Y3 LVDS - Out Camera Link Channel Tx 

PAIR 6 
7 - Not Used 

Connected with 100 ohm 
20 - Not Used 

PAIR 7 
8 -Z0 LVDS - Out Camera Link Transmitter 

21 +Z0 LVDS - Out Camera Link Transmitter 

PAIR 8 
9 -Z1 LVDS - Out Camera Link Transmitter 

22 +Z1 LVDS - Out Camera Link Transmitter 

PAIR 9 
10 -Z2 LVDS - Out Camera Link Transmitter 

23 +Z2 LVDS - Out Camera Link Transmitter 

PAIR 10 
11 -ZCLK LVDS - Out Camera Link Transmitter 

24 +ZCLK LVDS - Out Camera Link Clock Tx 

PAIR 11 
12 -Z3 LVDS - Out Camera Link Channel Tx 

25 +Z3 LVDS - Out Camera Link Channel Tx 

PAIR 12 
13 Ground Ground Cable Shield 

26 Ground Ground Cable Shield 

Table 7.2  Pin Assignments for Camera Link Connector 2 
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Model Tap Mode CL Configuration CL1 Connector CL2 Connector 

VTC-2K10.5C-C100A-80 

2 Tap BASE O X 

3 Tap BASE O X 

4 Tap MEDIUM O O 

8 Tap FULL O O 

10 Tap FULL O O 

Table 7.3  Connector Arrangement for the Camera Link Output Modes 

 

 

When you connect a frame grabber to Camera Link connectors on the camera using Camera 

Link cables, make sure that you connect to the correct Camera Link connectors. Incorrect 

connection of CL1 connector and CL2 connector may cause malfunction of the camera or 

communication problems between your computer and the camera. 
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7.3 Power Input Receptacle 

The power input receptacle is a Hirose 6-pin connector (part # HR10A-7R-6PB). The pin assignments and 

configurations are as follows: 

 

 

Figure 7.3  Pin Assignments for 6-pin Power Input Receptacle 

 

Pin Number Signal Type Description 

1, 2, 3 DC Power + Input DC Power Input 

4, 5, 6 DC Ground - Input DC Ground 

Table 7.4  Pin Arrangements for Power Input Receptacle 

 

 

 A recommended mating connector for the Hirose 6-pin connector is the Hirose 6-pin plug 

(part # HR10A-7P-6S) or the equivalent. 

 It is recommended that you use the power adapter, which has at least 3 A current output 

at 10 ~ 30 V voltage output (You need to purchase a power adapter separately.). 

 

Precaution for Power Input 

 

 

 Make sure the power is turned off before connecting the power cord to the camera. 

Otherwise, damage to the camera may result. 

 If the voltage applied to the camera is greater than specified in the specifications, damage 

to the camera may result. 
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7.4 Control I/O Receptacle 

The control I/O receptacle is a Hirose 4-pin connector (part # HR10A-7R-4S) and consists of an external trigger 

signal input and strobe output ports. The pin assignments and configurations are as follows: 

 

 

Figure 7.4  Pin Assignments for 4-pin Control I/O Receptacle 

 

Pin Number Signal Type Description 

1 Trigger Input Input 3.3 V ~ 5.0 V TTL input 

2 Scan Direction Input Input 3.3 V ~ 5.0 V TTL input 

3 DC Ground - DC Ground 

4 Strobe Out Output 
3.3 V TTL Output 

Output resistance: 47 Ω 

Table 7.5  Pin Arrangements for Control I/O Receptacle 

 

 

A recommended mating connector for the Hirose 4-pin connector is the Hirose 4-pin plug (part 

# HR10A-7P-4P) or the equivalent. 
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7.5 Trigger / Direction Input Circuit 

The following figure shows trigger signal input and TDI direction signal input circuit of the 4-pin connector. 

Transmitted trigger signal and TDI direction signal is applied to the internal circuit through a CMOS butter with a 

good noise margin. The minimum trigger width that can be recognized by the camera is 1 ㎲. If transmitted 

trigger signal is less than 1 ㎲, the camera will ignore the trigger signal. An external trigger and TDI direction 

circuit example is shown below. 

 

 

Figure 7.5  Trigger / Direction Input Schematic 

 

7.6 Strobe Output Circuit 

The strobe output signal comes out through a 3.3 V output level of Line Driver IC. A pulse width of the signal is 

synchronized with a Line Start trigger (shutter) signal of the camera (refer to 9.14 Strobe Mode). 

 

 

Figure 7.6  Strobe Output Schematic 
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8 Acquisition Control 

This chapter provides detailed information about the following elements involved with the image acquisition. 

 Line Start trigger – Trigger Mode 

 Line Rate control 

 

8.1 Line Start Trigger 

The Line Start trigger is used to begin line acquisition. Line Start trigger signals can be generated within the 

camera or may be applied externally by setting the Source parameter to CC1 or External. If a line start trigger 

signal is applied to the camera, the camera will begin to acquire line images. 

 

8.1.1 Trigger Mode 

The main parameter associated with the line start trigger is the Trigger Mode parameter. The Trigger Mode 

parameter for the line start trigger has two available settings: OFF and ON. 

 

8.1.1.1 Trigger Mode = OFF 

When the Trigger Mode parameter is set to OFF, the camera will generate all required line start trigger signals 

internally, and you do not need to apply line start trigger signals to the camera. 

If the Trigger Mode parameter is set to OFF, the camera will automatically begin generating line start trigger 

signals. 

 

 

Free Run 

When you set the Trigger Mode parameter to OFF, the camera will generate all required 

trigger signals internally. When the camera is set this way, it will constantly acquire images 

without any need for triggering by the user. This use case is commonly known as “free run”. 
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The rate at which the line start trigger signals are generated may be determined by the camera’s Line Rate 

parameter. 

 If the parameter is set to a value less than the maximum allowed line rate with the current camera settings, 

the camera will generate line start trigger signals at the rate specified by the parameter setting. 

 If the parameter is set to a value greater than the maximum allowed line rate with the current camera 

settings, the camera will generate line start trigger signals at the maximum allowed line rate. 

 

 

Figure 8.1  Trigger Mode = OFF 
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8.1.1.2 Trigger Mode = ON 

When the Trigger Mode parameter is set to ON, you must apply a line start trigger signal to the camera each 

time you want to begin an image acquisition. The Source parameter specifies the source signal that will act as 

the line start trigger signal. 

The available settings for the Source parameter are: 

 External: You can apply a line start trigger signal to the camera by injecting an externally generated  

 electrical signal (commonly referred to as a hardware or external trigger signal) into the Control  

 I/O receptacle on the camera. Refer to 7.5 Trigger / Direction Input Circuit for more information. 

 CC1: You can apply a line start trigger signal via CC1 port of the Camera Link frame grabber. 

 For more information, refer to your Camera Link frame grabber user manual. 

 

After setting the Source parameter, you must also set the Activation parameter. 

The available settings for the Activation parameter are: 

 Rising: Specifies that a rising edge of the electrical signal will act as the line start trigger. 

 Falling: Specifies that a falling edge of the electrical signal will act as the line start trigger. 

 Both: Specifies that both rising and falling edges of the electrical signal will act as the line start  

 trigger. 

 

When the Trigger Mode parameter is set to ON, the camera’s line rate can be controlled by manipulating the 

external trigger signal. At this point, it is important that you do not attempt to trigger images at a rate that is 

greater than the maximum allowed. 

 

 

Figure 8.2  Trigger Mode = ON  
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8.1.2 Using an External / CC1 Trigger Signal 

If the Trigger Mode parameter is set to ON, and the Source parameter is set to External or CC1, you must 

apply an external or CC1 trigger signal (line start) to the camera to begin image acquisition. 

To apply trigger signals via CC1 port of the Camera Link frame grabber, you must set the Source parameter to 

CC1. At that point, each time a proper CC1 trigger signal is applied to the camera by using the APIs provided by 

a Camera Link frame grabber manufacturer, the line start trigger signal will be applied to the camera. 

For more information, refer to your Camera Link frame grabber user manual. 

 

To apply trigger signals via hardware (external), you must set the Source parameter to External. At that point, 

each time a proper electrical signal is applied to the camera, an occurrence of the line start trigger signal will be 

recognized by the camera. 

 

A rising edge and/or a falling edge of the external or CC1 signal can be used to trigger image acquisition. 

The Activation parameter is used to select rising edge and/or falling edge triggering. 

When the camera is operating under control of an external or CC1 signal, the period of trigger signal will 

determine the rate at which the camera is acquiring images: 

 

 

 

For example, if you are operating a camera with an external trigger signal period of 20 ㎲ (0.00002 s): 

So in this case, the line rate is 50 ㎑. 
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8.1.3 Rescaler Mode 

With the Rescaler Mode, you can modulate the period of the external trigger signal as desired. 

For example, if you supply external trigger signals into the camera’s I/O receptacle using the conveyor’s 

encoder, the number of output pulses per revolution of the encoder is fixed. In this situation, you can modulate 

the period of the trigger signal received from the camera in the following manner to match the pitch of the image 

in vertical direction. 

 

Line Rate (㎐) = External Trigger Line Rate × Rescaler Rate 

 

 

Figure 8.3  Rescaler Rate = 0.5 

 

The commands related to Rescaler Mode are as follows. 

 

Configurator Parameters Command Value Description 

Rescaler Mode srm 
0: Off Disables Rescaler Mode. 

1: On Enables Rescaler Mode. 

Rescaler Rate srr f: 0.010000 ~ 100.000000 

Sets the trigger rescaler rate for 

converting trigger signals. 

f: Float, 0.010000 ~ 100.000000 

Rescaler Filter srf 

0: 16 

Sets the rescaler filter factor to 

decrease the jitter of the 

external trigger signals. 

1: 32 

2: 64 

3: 128 

4: 256 

5: 512 

Table 8.1  Commands related to Rescaler Mode 
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8.1.4 Trigger Statistics 

The Trigger Statistics feature allows you to determine the trigger signals applied to the camera and then 

converted by the Trigger Rescaler. 

The table below shows the parameters for the Trigger Statistics provided in the Configurator. 

 

Configurator Parameters Value Description 

Trigger Statistics 

InputTriggerRate - 
Displays the rate at which the input trigger signals 

are applied to the camera in ㎐. 

InputTriggerRateHighest - 
Displays the highest rate at which the input trigger 

signals are applied to the camera in ㎐. 

InputTriggerJitter - Displays the jitter of the input trigger signals in %. 

InputTriggerDuration - 
Displays the pulse duration of the input trigger 

signals in ㎲. 

RescaledTriggerRate - 
Displays the rate of the trigger signals converted by 

the Trigger Rescaler in ㎐. 

RescaledTrigger Jitter - 
Displays the jitter of the input trigger signals 

converted by the Trigger Rescaler in %. 

Table 8.2  Trigger Statistics Parameters 
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8.2 Maximum Allowed Line Rate 

In general, the maximum allowed acquisition line rate on the camera may be limited by the following factors: 

 Camera Link Tap Configuration (Tap Mode) Settings. 

When the camera is set for a Tap Mode that uses more taps, it will take less time to transfer acquired 

images from the camera to the Camera Link frame grabber in your computer. For example, if the camera is 

set to 8 Tap (Camera Link Full Configuration), it can typically transfer data out of the camera two times 

faster than when the camera is set to 4 Tap (Camera Link Medium). 

 The amount of time it takes to read acquired line images out of the image sensor and into the camera’s line 

buffer. This time varies depending on the length of image ROI. Images with a smaller length take less time 

to read out of the sensor. The image length is determined by the camera’s Width settings. 

 

The maximum allowed line rates of the VTC-2K10.5C camera depending on the Tap Mode settings are as 

follows. 

 

Tap Mode VTC-2K10.5C 

2 Tap 25.8 ㎑ 

3 Tap 37.8 ㎑ 

4 Tap 51.5 ㎑ 

8 Tap 100.0 ㎑ 

10 Tap 100.0 ㎑ 

When the camera is set for 4 Tap (CL Medium), 8 Tap (CL Full) or 10 Tap (CL Full), you must connect the 

camera to the Camera Link frame grabber using two Camera Link cables. 

Table 8.3  Maximum Allowed Line Rates depending on the Tap Mode settings 
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9 Camera Features 

9.1 Operation Mode 

The VTC-2K10.5C camera has two different operation modes: Area and TDI (Time Delayed Integration). 

If the Operation Mode parameter is set to Area, the camera will operate as an area scan camera using two 

dimensional array of pixels. This mode is useful for aligning the camera to your target object. 

If the Operation Mode parameter is set to TDI, the camera will operate as a high sensitivity line scan camera 

and provide up to 80× higher sensitivity than existing line scan cameras. 

The command related to Operation Mode is as follows. 

 

Configurator Parameter Command Value Description 

Operation Mode som 
0: TDI Operates the camera in the TDI mode. 

1: Area Operates the camera in the Area mode. 

Table 9.1  Command related to Operation Mode 
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9.2 TDI Stages 

In the TDI mode, the TDI Stages parameter is used to determine the number of integration stages used by the 

camera. For example, if the TDI Stages parameter is set to 80, the camera will acquire images with 80× higher 

sensitivity. 

In the Area mode, the TDI Stages parameter is used to determine the height of the image sensor. For example, 

if the Operation Mode parameter is set to Area and the TDI Stages parameter is set to 80 on the VTC-2K10.5C 

camera, the camera will acquire 2160 × 80 area images. 

The command related to TDI Stages is as follows. 

 

Configurator Parameter Command Value Description 

TDI Stages std 

1: 20 Sets the number of TDI Stages to 20. 

2: 40 Sets the number of TDI Stages to 40. 

3: 60 Sets the number of TDI Stages to 60. 

4: 80 Sets the number of TDI Stages to 80. 

Table 9.2  Command related to TDI Stages 
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9.3 Direction 

In the TDI mode, the Direction parameter is used to select the image sensor’s scan direction. You need to set 

the Direction parameter to Forward if the object being imaged will pass the bottom of the camera, and then 

pass the top of the camera. On the contrary, you need to set the Direction parameter to Reverse if the object 

being imaged will pass the top of the camera, and then pass the bottom of the camera. 

When you set the Direction parameter to Line 1, you can also select the scan direction by injecting an 

externally generated electrical signal (Low = Forward, High = Reverse) into the Control I/O receptacle on the 

camera. 

 

 

Figure 9.1  Direction 

 

Configurator Parameter Command Value Description 

Direction ssd 

0: Forward Scans images in the forward direction. 

1: Reverse Scans images in the Reverse direction. 

2: Line 1 Selects the scan direction using an external signal. 

Table 9.3  Command related to Scan Direction 

 

When you set the Direction parameter to Reverse in the Area mode, you can acquire vertically flipped images. 
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9.4 Region of Interest 

The Region of Interest (ROI) feature allows you to specify a portion of the sensor lines. During operation, only 

the pixel information from the specified portion of the lines is read out of the sensor and transmitted from the 

camera to your computer. 

The ROI is referenced to the left end of the sensor array. The location and size of the ROI is defined by declaring 

the Offset X and Width settings. For example, suppose that you set the Offset X parameter to 48 and the Width 

parameter to 288 as shown in the figure below. With these settings, the camera will read out and transmit pixel 

values for pixels 48 through 335. 

 

 

Figure 9.2  Region of Interest 

 

9.4.1 Setting the ROI 

By default, the ROI is set to use the full resolution of the camera’s image sensor. You can change the size and 

location of the ROI by changing the Offset X and Width parameter values. 

When you are setting the camera’s region of interest, you must consider the following guidelines: 

 The sum of the Offset X and Width setting values must not exceed the width of the camera’s image sensor. 

For example, on the VTC-2K10.5C camera, the sum of the Offset X and Width setting values must not 

exceed 2160. 

 The Offset X setting value can be set to 0 and can be increased in increments of 48. The Width setting 

values must be a minimum of 48 and can be set to a multiple of 48. 

 

 

Your Camera Link frame grabber may place additional restrictions on how the ROI location and 

size must be set. Refer to your Camera Link frame grabber user manual for more information. 
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The maximum allowed line rates of the VTC-2K10.5C camera depending on the ROI settings are as follows. 

 

Width 2 Tap 3 Tap 4 Tap 8 Tap / 10 Tap 

384 100.0 ㎑ 100.0 ㎑ 100.0 ㎑ 100.0 ㎑ 

528 100.0 ㎑ 100.0 ㎑ 100.0 ㎑ 100.0 ㎑ 

720 78.1 ㎑ 100.0 ㎑ 100.0 ㎑ 100.0 ㎑ 

1056 53.4 ㎑ 79.8 ㎑ 100.0 ㎑ 100.0 ㎑ 

1536 36.7 ㎑ 55.1 ㎑ 73.2 ㎑ 100.0 ㎑ 

2160 25.8 ㎑ 37.8 ㎑ 51.5 ㎑ 100.0 ㎑ 

Table 9.4  Maximum Allowed Line Rates by ROI Changes (RGB8 Pixel Format) 

 

 

To acquire images at the maximum allowed line rate, you need to set the camera’s Tap Mode 

to 8 Tap / 10 Tap (Camera Link Full Configuration). In this case, you must connect the camera 

to the Camera Link frame grabber using two Camera Link cables. 
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9.5 Pixel Format 

The camera processes image data in the unit of 12 bit internally. You can determine the format of these image 

data transmitted from the camera by using the Pixel Format parameter. 

 

 

Figure 9.3  Data Format 

 

The command related to Pixel Format is as follows. 

 

Configurator Parameter Command Value Description 

Pixel Format sdb 

8: RGB8 Sets the pixel format to RGB 8 bit. 

10: RGB10 Sets the pixel format to RGB 10 bit. 

12: RGB12 Sets the pixel format to RGB 12 bit. 

108: BGR8 Sets the pixel format to BGR 8 bit. 

110: BGR10 Sets the pixel format to BGR 10 bit. 

112: BGR12 Sets the pixel format to BGR 12 bit. 

Table 9.5  Command related to Pixel Format 
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9.6 Gain and Black Level 

Increasing the Gain parameter increases all pixel values of the image. This results in a higher grey value output 

from the camera for a given amount of output from the image sensor. 

1. Select a Gain Control parameter as desired. 

2. Set the Gain parameter to the desired value. 

 

Adjusting the Black Level parameter will result in an offset to the pixel values output from the camera. 

1. Set the Black Level parameter to the desired value. 

2. The available setting range varies depending on the Pixel Format settings. 

 

The commands related to Gain and Black Level are as follows. 

 

Configurator Parameters Command Value Description 

Analog Gain sag 1×, 2×, 3×, 4× Sets an absolute analog gain value. 

Digital Gain sdg f: 1.0× ~ 8.0× 
Sets an absolute digital gain value. 

f: Float, 0 ~ 18 ㏈ 

Black Level sdbl n: -255 ~ 255 
Sets a physical black level value (@ 8 bits) 

n: Integer 

Table 9.6  Commands related to Gain and Black Level 
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9.7 White Balance 

The VTC-2K10.5C camera allows you to adjust the white balance manually or automatically by setting the gain 

values for the Red, Green and Blue channels. To adjust the white balance manually, use the ‘srg’ command to 

set the intensity of each color. If you set the intensity of a color to a value greater than 1.0, the intensity of the 

color will be proportionally increased to the setting value. For example, if you execute the ‘srg b 1.5’ command, 

the blue intensity will be increased by 50%. 

The commands related to White Balance are as follows. 

 

Command Value Description 

RGB Gain 

srg r 1.0× ~ 3.9× Sets the intensity of the red pixels. 

srg g 1.0× ~ 3.9× Sets the intensity of the green pixels. 

srg b 1.0× ~ 3.9× Sets the intensity of the blue pixels. 

Table 9.7  Commands related to White Balance 

 

To adjust the white balance automatically, execute the ‘arg’ command. The intensity values for the Red and Blue 

will be automatically adjusted by referring to the Green. 

 

Command Value Description 

Auto White Balance arg - White Balance is adjusted once and then Off. 

Table 9.8  Command related to Auto White Balance 

 

 

  



 VTC-2K10.5C-C100A-80 

 Page 38 of 86 D-18-565 

9.8 Color Correction Matrix 

The VTC-2K10.5C camera provides the Color Transformation feature. After adjusting the white balance, you can 

adjust colors to your light source by using the Color Transformation feature. The Color Transformation feature 

converts the RGB triplet from the camera color space to the RGB triplet of the final color space when you enter 

nine Gain factors in the 3 × 3 matrix as shown below. 

 

 

 

The commands related to Color Correction Matrix are as follows. 

 

Command Value Description 

Color Correction Matrix 

sccm 0 

-4.0× ~ 4.0× 

Gain00: Sets red contribution to the red pixels. 

sccm 1 Gain01: Sets green contribution to the red pixels. 

sccm 2 Gain02: Sets blue contribution to the red pixels. 

sccm 3 Gain10: Sets red contribution to the green pixels. 

sccm 4 Gain11: Sets green contribution to the green pixels. 

sccm 5 Gain12: Sets blue contribution to the green pixels. 

sccm 6 Gain20: Sets red contribution to the blue pixels. 

sccm 7 Gain21: Sets green contribution to the blue pixels. 

sccm 8 Gain22: Sets blue contribution to the blue pixels. 

Table 9.9  Commands related to Color Correction Matrix 
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9.9 LUT 

The Lookup Table (LUT) feature allows you to convert original image values to certain level values. 

 

Luminance 

Since it is mapped one to one for each level value, 12 bit output can be connected to 12 bit input. The LUT is in 

the form of table that has 4096 entries between 0~4095 and the VTC-2K10.5C camera provides a non-volatile 

space for LUT data storage. You can determine whether to apply LUT. For more information about how to 

download LUT to the camera, refer to Appendix B. 

 

12-bit Data
4096 entry 

Lookup Table
12-bit Data

 

Figure 9.4  LUT Block 

 

 

Figure 9.5  LUT at Gamma 0.5 
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The command related to LUT is as follows. 

 

Configurator Parameters Command Value Description 

LUT sls 
0: Off Disables the LUT feature. 

1: On Enables the LUT feature. 

Table 9.10  Command related to LUT 
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9.10 Dark Signal Non-uniformity Correction 

In theory, when a digital camera acquires images in complete darkness, all of the pixel values in the image 

should be near zero and they should be equal. In practice, however, slight variations in the performance of the 

pixels in the sensor will cause some variations in the pixel values output from the camera when the camera is 

acquiring in darkness. This variation is known as Dark Signal Non-uniformity (DSNU). The VTC-2K10.5C camera 

provides the DSNU Correction feature. 

 

The commands related to DSNU are as follows. 

 

Configurator Parameters Command Value Description 

Generate All gdda - 
Generates and saves the DSNU data for each Analog 

Gain setting value (1×, 2×, 3×, 4×). 

Generate gdd - Generates the DSNU data. 

Save to Flash sdd - 

Saves the generated DSNU data in the non-volatile 

memory. 

 The data generated by executing the Generate 

command are saved in the volatile memory so that 

the data are lost if the camera is reset or if power is 

turned off. To use the data after the camera is 

powered on or reset, save them in the non-volatile 

memory. 

Load from Flash ldd - 
Loads the DSNU data from the non-volatile memory into 

the volatile memory. 

Table 9.11  Commands related to DSNU 
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9.10.1 Generating and Saving User DSNU Correction Values 

To generate and save user DSNU correction values, use the following procedure. 

 

 

For optimum DSNU correction results, we recommend that you generate DSNU data after the 

temperature of the camera housing has been stabilized. 

 

1. The camera will use the entire sensor when generating DSNU correction values. Therefore, we recommend 

that you set the ROI setting to use the entire width of the sensor. 

2. Ensure that the camera will be acquiring line images in complete darkness by covering the camera lens, 

closing the iris in the lens, or darkening the room. 

3. Begin acquiring line images either by setting the camera for the Free-Run mode or by supplying external 

trigger signals to trigger line acquisitions. 

4. Generate DSNU correction values. 

 Go to step 5 if you execute the Generate command to generate DSNU data. 

 Go to step 6 if you execute the Generate All command to generate DSNU data. 

 

5. If you execute the Generate command, 

 a. The camera generates DSNU data according to the current Analog Gain setting value. The camera must 

acquire at least 4096 line images to create a set of DSNU correction values. 

 b. After completing 4096 line acquisitions, the generated DSNU correction values will be activated and 

saved in the camera’s volatile memory. 

 c. To save the generated DSNU correction values in the camera’s Flash (non-volatile) memory, execute the 

Save to Flash command. The previous DSNU values for the current Analog Gain setting value saved in 

the memory will be overwritten. 

 

6. If you execute the Generate All command, 

 a. The camera generates the DSNU data for each Analog Gain setting value (1×, 2×, 3×, 4×) and then 

executes the Save to Flash command automatically. The camera must acquire at least 4096 line images 

to create sets of DSNU correction values. 

 b. After completing 4096 line acquisitions, the generated DSNU correction values according to the current 

Analog Gain setting values will be activated. 

 

7. If you change the Analog Gain setting values or want to load the existing values in the Flash memory, 

execute the Load from Flash command.  
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Figure 9.6  Generating and Saving DSNU Correction Values 
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9.11 Photo Response Non-uniformity Correction 

In theory, when a line scan camera acquires images with the camera viewing a uniform light-colored target in 

bright light, all of the pixel values in the image should be near the maximum grey value and they should be 

equal. In practice, however, slight variations in the performance of the pixels in the sensor, variations in the 

optics, and variations in the lighting will cause some variations in the pixel values output from the camera. This 

variation is known as Photo Response Non-uniformity (PRNU). The VTC-2K10.5C camera provides the PRNU 

Correction feature and five storage locations for PRNU correction values. 

 

The commands related to PRNU are as follows. 

 

Configurator Parameters Command Value Description 

PRNU Correction sprnu 
0: Off Disables the PRNU Correction feature. 

1: On Enables the PRNU Correction feature. 

PRNU Selector spi 0/1/2/3/4 
Selects a location to save PRNU data to or load 

PRNU data from. 

Auto gpd 0 Select to set the PRNU Target Level automatically. 

Target - 1 ~ 255 Sets the PRNU Target Level (@ 8 bit pixel format). 

Generate gpd n: 0 ~ 255 
Generates the PRNU data. 

0: Auto, 1 ~ 255: Sets the PRNU Target Level. 

Save to Flash spd - 

Saves the generated PRNU data in the non-

volatile memory. 

 The data generated by executing the 

Generate command are saved in the volatile 

memory so that the data are lost if the camera 

is reset or if power is turned off. To use the 

data after the camera is powered on or reset, 

save them in the non-volatile memory. 

Load from Flash lpd - 
Loads the PRNU data from the non-volatile 

memory into the volatile memory. 

Table 9.12  Commands related to PRNU 
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9.11.1 Generating and Saving User PRNU Correction Values 

To generate and save user PRNU correction values, use the following procedure. 

 

 

 We strongly recommend that you generate new PRNU correction values whenever you 

make a change to the optics or lighting or if you change the camera’s line rate. 

 For optimum PRNU correction results, we recommend that you generate DSNU correction 

values first before generating PRNU correction values. 

 

1. The camera will use the entire sensor when generating PRNU correction values. Therefore, we recommend 

that you set the ROI settings to use the entire width of the sensor. 

2. Place a uniform white target in the field of view of the camera. Adjust the optics, lighting and line rate as you 

would for normal operation. We recommend that you make adjustments to achieve the digital output level in 

a range from 100 to 200 (Gain: 1.00 at 8 bit). 

3. Begin acquiring line images either by setting the camera for the Free-Run mode or by supplying external 

trigger signals to trigger line acquisition. 

4. Set the Target Level. 

 To set the Target Level automatically, select the Auto check box. 

 To set the Target Level manually, deselect the Auto check box and input the target level in a range from 

0 to 255. 

5. Execute the Generate command to generate PRNU correction values. 

6. The camera must acquire at least 4096 line images to create a set of PRNU correction values. 

7. After completing 4096 line acquisitions, the generated PRNU correction values will be activated and saved 

in the camera’s volatile memory. 

8. To save the generated PRNU correction values in the camera’s Flash (non-volatile) memory, specify a 

location to save by using the PRNU Selector parameter and execute the Save to Flash command. 

The existing values in the memory will be overwritten. 

To ignore the generated PRNU correction values and load the existing values in the Flash memory, specify 

a location to load from by using the PRNU Selector parameter and execute the Load from Flash 

command. 
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9.12 Reverse X 

The Reverse X feature lets you flip the image horizontally. This feature is available in all operation modes. 

 

 

Figure 9.7  Original Image 

 

 

Figure 9.8  Reverse X Image 

 

The command related to Reverse X is as follows. 

 

Configurator Parameters Command Value Description 

Reverse X shf 
0 Disables the Reverse X feature. 

1 Enables the Reverse X feature. 

Table 9.13  Command related to Reverse X 
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9.13 Camera Link Output 

The VTC-2K10.5C camera supports 2 Tap, 3 Tap, 4 Tap, 8 Tap and 10 Tap Camera Link output modes. The 

number of taps represents the number of pixel data that will be output on each cycle of the Camera Link pixel 

clock. The maximum allowed line rate will be changed according to the Tap Mode settings. The line image data 

is transmitted in the interleaved order as shown in the figure below. 

 

 

Figure 9.9  Camera Link Output Mode 

 

The command related to Camera Link Output Mode is as follows. 

 

Configurator Parameters Command Value Description 

Tap Mode scl 

0: 2 Tap Sets the Camera Link Output Mode to 2 Tap. 

1: 4 Tap Sets the Camera Link Output Mode to 4 Tap. 

2: 8 Tap Sets the Camera Link Output Mode to 8 Tap. 

3: 10 Tap Sets the Camera Link Output Mode to 10 Tap. 

4: 3 Tap Sets the Camera Link Output Mode to 3 Tap. 

Table 9.14  Command related to Camera Link Output Mode  
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9.14 Strobe Mode 

The VTC-2K10.5C camera can output pulse signals through the control I/O receptacle. You can set a width of 

the pulse signal by using the Strobe Mode feature. This feature is useful when you need to supply source signal 

to the other device such as a Strobe Controller. 

The commands related to Strobe Mode are as follows. 

 

Configurator Parameters Command Value Description 

Strobe Mode ssm 

0: Off Disables the Strobe Mode feature. 

1: Timed 
Outputs pulse signals according to the 

Strobe Duration setting value. 

2: Pulse Width 

Outputs pulse signals of which the period is 

equal to the trigger signals applied to the 

camera. 

3: On Outputs continuous High signals. 

Strobe Inverter ssp 
0 Deselect not to invert the output signal. 

1 Select to invert the output signal. 

Strobe Duration ssr f: 1.00 ~ 1000.00 

Sets a duration of pulse signal in 

microseconds when the Strobe Mode is set 

to Timed. 

Strobe Out Delay sto f: 0.00 ~ 1000.00 
Sets a delay to the current output signal in 

microseconds. 

Table 9.15  Commands related to Strobe Mode 

 

 

  



 VTC-2K10.5C-C100A-80 

 Page 49 of 86 D-18-565 

9.15 Temperature Monitor 

The camera has an embedded sensor chip to monitor the internal temperature. 

The command related to the device temperature is as follows. 

 

Command Description 

gct Displays device temperature in Celsius. 

Table 9.16  Command related to Device Temperature 

 

9.16 Status LED 

A red/green LED is installed on the back panel of the camera to inform the operation status of the camera. 

LED status and corresponding camera status are as follows. 

 

Status LED Descriptions 

Steady Red Camera is not initialized. 

Steady Green Camera is waiting for transmitting images. 

Fast Flashing Green Camera is acquiring images. 

Table 9.17  Status LED 

 

9.17 Device Reset 

Resets the camera physically to power off and on. The command related to Device Reset is as follows. 

 

Command Description 

rst Resets the camera physically. 

Table 9.18  Command related to Device Reset 
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9.18 Test Image 

To check normal operation of the camera, it can be set to output test images created inside, instead of image 

data from the image sensor. There are three types of test images; image with different value in horizontal 

direction (Test #1), image with different value in diagonal direction (Test #2), and moving image with different 

value in diagonal direction (Test #3). 

The command related to Test Image is as follows. 

 

Configurator Parameters Command Value Description 

Test Image sti 

0: Off Disables the Test Image feature. 

1: Test #1 Sets the Test Image to Test #1. 

2: Test #2 Sets the Test Image to Test #2. 

3: Test #3 Sets the Test Image to Test #3. 

Table 9.19  Command related to Test Image 

 

 

Figure 9.10  Test #1 
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Figure 9.11  Test #2 

 

 

Figure 9.12  Test #3 

 

 

The test image may look different because the region of the test image may vary depending on 

the camera’s resolution. 
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9.19 Camera Link Pixel Clock 

The Pixel Clock feature provided by the VTC-2K10.5C camera allows you to select a Camera Link pixel clock so 

that you can increase the available Camera Link cable length or extend the Camera Link bandwidth. Typically, 

you can extend the Camera Link cable length up to 15 meters with the Camera Link pixel clock of 40 ㎒. 

The command related to Pixel Clock is as follows. 

 

Configurator Parameters Command Value Description 

Pixel Clock sccs 

0: 40 ㎒ Sets the Camera Link Pixel Clock to 40 ㎒. 

1: 60 ㎒ Sets the Camera Link Pixel Clock to 60 ㎒. 

2: 80 ㎒ Sets the Camera Link Pixel Clock to 80 ㎒. 

3: 85 ㎒ Sets the Camera Link Pixel Clock to 85 ㎒. 

Table 9.20  Command related to Pixel Clock 

 

9.20 Field Upgrade 

The camera provides a feature to upgrade the camera’s firmware and FPGA logic through the Camera Link 

interface rather than disassemble the camera in the field. Refer to Appendix A for more details about how to 

upgrade. 
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10 Camera Configuration 

10.1 Setting Commands 

You can configure all camera settings via RS-644 serial interface of the Camera Link. When you want to control 

the camera using a terminal or to access directly to the camera at your application, you need to set your network 

as follows. 

 

 Baud Rate: 115200 bps 

 Data Bit: 8 bit 

 Parity Bit: No Parity 

 Stop Bit: 1 stop bit 

 Flow Control: None 

 

All camera setting commands are transmitted in the ASCII command type except a command for transmitting a 

large file such as firmware download. All camera setting commands are transmitted from the user application 

and then the camera returns a response (“OK”, “Error” or information) for a command. When you execute a write 

command, the camera returns a response to inform whether the command has been successfully executed. 

When you execute a read command, the camera returns an error or information. 

 

Command Format: 

<command> <parameter1> <parameter2> <cr> 

0 – 2 parameters follow the command. 

Response: 

If a write command is successfully executed 

OK <cr> <lf> 

 

ex) Write Command 

 

In response to a “set 100” command the camera will return (in hex value) 

Command:  73 65 74 20 31 30 30 0D 

  set 100<cr> 

Response:  73 65 74 20 31 30 30 0D 0A 4F 4B 0D 0A 3E 

 set 100<cr><lf> OK<cr><lf> > 

 Echo result prompt 
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If a read command is successfully executed 

<parameter1> <cr> <lf> 

 

ex) Read Command 

 

In response to a “get” command the camera will return (in hex value) 

Command:  67 65 74 0D 

 get <cr> 

Response:  67 65 74 0D 0A 31 30 30 0D 0A 3E 

 get<cr><lf> 100<cr><lf> > 

 Echo response prompt 

 

If a command is not executed successfully 

Error: <Error Code> <cr> <lf> 

 

Prompt: 

A prompt always follows after the response. ‘>’ is used as prompt. 

 

Types of Error Code 

0x80000481: value of parameter is not valid 

0x80000482: the number of parameters is not matched 

0x80000484: command does not exist 

0x80000486: no permission to execute 

 

 

  



 VTC-2K10.5C-C100A-80 

 Page 55 of 86 D-18-565 

10.2 User Set Control 

You can save the current camera settings to the camera’s internal Flash memory. You can also load the camera 

settings from the camera’s internal Flash memory. The camera provides two setups to save and three setups to 

load settings. 

The commands related to User Set Control are as follows. 

 

Configurator Menus Command Value Description 

Load Setting lcf 

0: Factory Space Loads the Factory Default Settings to the camera. 

1: User 1 Space Loads the User 1 Settings to the camera. 

2: User 2 Space Loads the User 2 Settings to the camera. 

Save Setting sct 
1: User 1 Space Saves the current settings to User 1 Setting. 

2: User 2 Space Saves the current settings to User 2 Setting. 

Start-Up sci 

0: Factory Setting Applies the Factory Default Settings when reset. 

1: User 1 Setting Applies the User 1 Settings when reset. 

2: User 2 Setting Applies the User 2 Settings when reset. 

Table 10.1  Commands related to User Set Control 
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The camera settings stored in the Default can be loaded into the camera’s workspace, but cannot be changed. 

The settings set in the workspace will be lost if the camera is reset or powered off. To use the current setting 

values in the workspace after a reset, you must save the settings to one of the user spaces. 

 

 

Figure 10.1  User Set Control 
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10.2.1 Factory Default Setting Values 

When you power the camera for the first time on, the factory default setting values will be loaded into the camera 

and the factory default setting values are as follows: 

 

Configurator Parameters Value 

Operation Mode TDI 

Scan Direction Forward 

TDI Stages Maximum Integration Stages 

Trigger Mode Off 

Test Image Off 

Pixel Format RGB 8 

PRNU Mode On 

DSNU Mode On 

Analog Gain 1 

Digital Gain 1 

Line Rate 35 ㎑ 

Table 10.2  Factory Default Setting Values 
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10.3 Command List 

You can set all features provided by the VTC-2K10.5C camera by using the following commands. 

 

Command Syntax Return Value Description 

Help help String Displays a list of all commands. 

Set Offset X 

Get Offset X 

sox n 

gox 

OK 

n 

X coordinate of start point ROI 

n: X axis offset 

Set Image Width 

Get Image Width 

siw n 

giw 

OK 

n 

Width of ROI, n: Width value 

 48 ~ 2160 

Set Test Image 

Get Test Image 

sti 0|1|2|3 

gti 

OK 

0|1|2|3 

Sets the Test Image. 

0: Test Image Off 

1, 2: Fixed pattern image 

3: Moving pattern image 

Set Scan Direction 

Get Scan Direction 

ssd 0|1|2 

gsd 

OK 

0|1|2 

Sets the camera’s scan direction. 

0: Forward 

1: Reverse 

2: Line 1 (External Port) 

Set Data Bit 

Get Data Bit 

sdb 8|10|12|XX 

gdb 

OK 

8|10|12 

Sets the Pixel Format. 

8: RGB 8 bit 

10: RGB 10 bit 

12: RGB 12 bit 

108: BGR 8 bit 

110: BGR 10 bit 

112: BGR 12 bit 

Set TDI Stage 

Get TDI Stage 

std 1|2|3|4 

gtd 

OK 

1|2|3|4 

Sets the number of TDI Stages. 

1: 20 Stage 

2: 40 Stage 

3: 60 Stage 

4: 80 Stage 

Set Line Rate 

Get Line Rate 

slr f 

glr 

OK 

f 

Sets the camera’s line rate. 

f: Line period (㎲) <Float> 

Table 10.3  Command List #1 
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Command Syntax Return Value Description 

Set Exposure Time 

Get Exposure Time 

set n 

get 

OK 

n 

Sets an exposure time (When the 

Operation Mode is set to Area) 

n: exposure time in microseconds (㎲) 

Set Trigger Mode 

Get Trigger Mode 

stm 0|1 

gtm 

OK 

0|1 

Sets the Trigger Mode. 

0: Free-Run mode 

1: Activates the Trigger Mode. 

Set Horizontal Flip 

Get Horizontal Flip 

shf 0|1 

ghf 

OK 

0|1 

Enables the Reverse X feature. 

0: Disables the Reverse X feature. 

1: Enables the Reverse X feature. 

Set Trigger Source 

Get Trigger Source 

sts 1|5 

gts 

OK 

1|5 

Specifies a source signal when the Trigger 

Mode is set to On. 

1: CC1 port (Camera Link) 

5: External port (LineIn0) 

Set Trigger Activation 

Get Trigger Activation 

sta 0|1|2 

gta 

OK 

0|1|2 

Specifies a polarity of trigger when the 

Trigger Mode is set to On. 

0: Falling 

1: Rising 

2: Both 

Set Trigger Rescaler Mode 

Get Trigger Rescaler Mode 

srm 0|1 

grm 

OK 

0|1 

Sets the Trigger Rescaler feature. 

0: Disables the Trigger Rescaler feature. 

1: Enables the Trigger Rescaler feature. 

Set Trigger Rescaler Rate 

Get Trigger Rescaler Rate 

srr f 

grr 

OK 

F 

Sets the Trigger Rescale Rate. 

f: Rescaler rate <Float> 

(Setting range: 0.010 ~ 100.000) 

Set Trigger Rescaler Filter 

Get Trigger Rescaler Filter 

srf 0|1|2|3|4|5 

grf 

OK 

0|1|2|3|4|5 

Sets the Trigger Rescaler Noise Filter. 

0: 16 1: 32 

2: 64 3: 128 

4: 256 5: 512 

Set Operation Mode 

Get Operation Mode 

som 0|1 

gom 

OK 

0|1 

Sets the camera’s operation mode. 

0: TDI mode 

1: Area mode 

Table 10.4  Command List #2 
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Command Syntax Return Value Description 

Set Strobe Mode 

Get Strobe Mode 

ssm 0|1|2|3 

gsm 

OK 

0|1|2|3 

Sets whether to output strobe signals. 

0: Off 

1: Outputs strobe signals according to the 

Strobe Duration setting value. 

2: Outputs signals of which the width is equal 

to the trigger signals applied to the camera. 

3: Outputs continuous High signals. 

Set Strobe Inverter 

Get Strobe Inverter 

ssp 0|1 

gsp 

OK 

0|1 

Sets whether to invert strobe signals. 

0: Disables the inversion of strobe signals. 

1: Enables the inversion of strobe signals. 

Set Strobe Delay 

Get Strobe Delay 

sto f 

gto 

OK 

f 

Sets a delay to the strobe signal. 

f: Strobe out delay (㎲) <Float> 

(Setting range: 0.00 ~ 1000.00 ㎲) 

Set Strobe Duration 

Get Strobe Duration 

ssr f 

gsr 

OK 

f 

Sets a width of the strobe signal in 

microseconds when the Strobe Mode is set 

with the ssm 1 command. 

f: Strobe duration (㎲) <Float> 

(Setting range: 1.00 ~ 1000.00 ㎲) 

Set Analog Gain 

Get Analog Gain 

sag 1|2|3|4 

gag 

OK 

1|2|3|4 

Sets the Analog Gain. 

1/2/3/4: Analog gain (1, 2, 3, 4) 

Set Digital Gain 

Get Digital Gain 

sdg f 

gdg 

OK 

f 

Sets the Digital Gain. 

f: Digital gain <Float> 

(Setting Range: 1.000 ~ 8.000) 

Set Black Level 

Get Black Level 

sdbl n 

gdbl 

OK 

n 

Sets the Black Level. 

n: Black level (Setting Range: -255 ~ 255) 

Set RGB Gain 

Get RGB Gain 

srg  r|g|b  g 

grg  r|g|b 

OK 

g 

Sets the intensity of color pixels. 

r|g|b: Red / Green / Blue pixels 

g: Gain value (1.0× ~ 3.9×) 

Auto White Balance arg OK Automatically adjusts the white balance once. 

Set Color Correction Matrix 

Get Color Correction Matrix 

sccm 0 ~ 8 

gccm 

OK 

0 ~ 8 

Sets gain factors in the Color Correction 

matrix. 

(Setting range: -4.0× ~ 4.0×) 

Table 10.5  Command List #3  
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Command Syntax Return Value Description 

Generate DSNU Data All gdda OK 
Generates and saves the DSNU data for 

each Analog Gain setting values. 

Generate DSNU Data gdd OK 
Generates the DSNU data for the current 

Analog Gain setting value. 

Save DSNU Data sdd OK 
Saves the generated DSNU data in the 

non-volatile memory. 

Load DSNU Data ldd OK 
Loads the DSNU data from the non-

volatile memory into the volatile memory. 

Set DSNU Transform sdt n1 (n2) v1 OK 

Performs additional correction to the 

PRNU correction values. 

n1: X coordinate of a start pixel 

n2: X coordinate of an end pixel 

v1: Black level value to be added to the 

specified region (-255 ~ 255) 

Set DSNU Coefficient 

Get DSNU Coefficient 

sdc n f1 

sdc n1 n2 f1 

gdc n1 (n2) 

OK 

f1 

Sets or retrieves the DSNU Correction 

Coefficient. 

n: X coordinate of a pixel to set 

n1: X coordinate of a start pixel 

n2: X coordinate of an end pixel 

f1: DSNU correction coefficient 

(Black Level = 0.1 ~ 4095) 

Set LUT Select 

Get LUT Select 

sls 0|1 

gls 

OK 

0|1 

Sets the LUT feature. 

0: Disables the LUT feature. 

1: Enables the LUT feature. 

Set Camera Link mode 

Get Camera Link mode 

scl 0|1|2|3|4 

gcl 

OK 

0|1|2|3|4 

Sets the Camera Link Output mode. 

0: 2 Tap 

1: 4 Tap 

2: 8 Tap 

3: 10 Tap 

4: 3 Tap 

Table 10.6  Command List #4 
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Command Syntax Return Value Description 

Set Camera Link Clock Speed 

Get Camera Link Clock Speed 

sccs 0|1|2|3 

gccs 

OK 

0|1|2|3 

Sets the Camera Link Pixel Clock. 

0: 40 ㎒ 

1: 60 ㎒ 

2: 80 ㎒ 

3: 85 ㎒ 

Generate PRNU Data gpd n OK 

Generates the PRNU data. 

n: Target level 

(Setting Range: 1 ~ 255, 0: Auto) 

Set PRNU Mode 

Get PRNU Mode 

sprnu 0|1 

gprnu 

OK 

0|1 

Sets the PRNU Correction feature. 

0: Disables the PRNU Correction feature. 

1: Enables the PRNU Correction feature. 

Save PRNU Data spd OK 
Saves the PRNU data in the non-volatile 

memory. 

Load PRNU Data lpd OK 
Loads the PRNU data from the non-

volatile memory into the volatile memory. 

PRNU Selector 
spi 0|1|2|3|4 

gpi 

OK 

0|1|2|3|4 

Selects a location to save PRNU data to 

or load PRNU data from. 

0/1/2/3/4: PRNU data storage area 

Set PRNU Transform spt n1 (n2) f1 OK 

Performs additional correction to the 

PRNU correction values. 

n1: X coordinate of a start pixel 

n2: X coordinate of an end pixel 

f1: Gain value to be multiplied to the 

specified region (0.1 ~10.0) 

Set PRNU Coefficient 

Get PRNU Coefficient 

spc n f1 

spc n1 n2 f1 

gpc n1 (n2) 

OK 

f1 

Sets or retrieves the PRNU Correction 

Coefficient. 

n: X coordinate of a pixel to set 

n1: X coordinate of a start pixel 

n2: X coordinate of an end pixel 

f1: PRNU correction coefficient 

(Gain = 0.1 ~10.0) 

Table 10.7  Command List #5 
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Command Syntax Return Value Description 

Load Config From lcf 0|1|2 OK 

Loads camera setting values to the camera’s 

work space. 

0: Loads from Factory space. 

1: Loads from User 1 space. 

2: Loads from User 2 space. 

Save Config To sct 1|2 OK 

Saves the current camera setting values. 

1: Saves to User 1 space. 

2: Saves to User 2 space. 

Set Config Initialization 

Get Config Initialization 

sci 0|1|2 

gci 

OK 

0|1|2 

Specifies setting values to be loaded when reset. 

0: Applies Factory default settings when reset. 

1: Applies User 1 settings when reset. 

2: Applies User 2 settings when reset. 

Get MCU Version gmv String Displays the version of camera MCU. 

Get Model Number gmn String Displays camera model name. 

Get FPGA Version gfv String Displays the version of camera FPGA. 

Get Serial Number gsn piece String Displays the serial number of the camera. 

Get Current Temperature gct String Displays device temperature in Celsius. 

Reset rst - Resets the camera. 

Table 10.8  Command List #6 
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11 Configurator GUI 

Configurator, a sample application, is provided to control the VTC-2K10.5C camera. Configurator provides easy-

to-use Graphic User Interface (GUI) that allows users to view and change the camera’s settings mentioned in the 

previous chapters. 

 

11.1 Camera Scan 

When you execute the Configurator.exe file while the camera is powered on, the Camera Scan window appears 

as shown in the figure below. At this time, the Configurator checks serial ports of your computer and DLL 

provided by the Camera Link to scan whether a camera is connected. If the Configurator finds a connected 

camera, it displays the model name of the camera on the Camera Scan window. If the camera is not displayed 

on the window, check the cable connections and power of the camera, and then press the refresh button. 

Double-clicking the model name of the camera displayed on the window will launch the Configurator and display 

the current parameter settings of the camera connected. 

 

 

Figure 11.1  Configurator Loading Window 
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11.2 Menu 

The menu bar of the Configurator provides the File, Start-Up, Tool and About menus. 

 

11.2.1 File 

 

 

Figure 11.2  File Menu 

 

 Load Setting: Loads the camera setting values from the camera memory (Factory, User1 or User2)  

 or user’s computer (File). 

 Save Setting: Saves the camera setting values to the camera memory (User1 or User2) or user’s  

 computer (File). 

 System Upgrade: Upgrades the MCU or FPGA logic. 

 Exit: Exits the Configurator. 
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11.2.2 Start-Up 

The Start-Up menu allows you to select the camera setting values to be loaded when the camera is powered on. 

 

 

Figure 11.3  Start-Up Menu 

 

 Factory Setting: Loads the camera setting values from the Factory space when the camera is powered on. 

 User 1 Setting: Loads the camera setting values from the User1 space when the camera is powered on. 

 User 2 Setting: Loads the camera setting values from the User2 space when the camera is powered on. 
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11.2.3 Tool 

 

 

Figure 11.4  Tool Menu 

 

 Refresh: Loads and displays the current camera setting values on the Configurator. 

 Terminal: Displays the Terminal window. The Terminal window displays a user command for the  

 feature that you have set on the Configurator. To hide the Terminal window, uncheck  

 Terminal by clicking it again. 

 Color Calibration: Displays the window for adjusting the white balance. When you click the Auto White  

 Balance button, the white balance is adjusted once and then Off. 

 

 

Figure 11.5  Color Calibration 

 

 Factory Setting: Not supported for users. 

 High Speed: Not supported in the Configurator.  
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11.2.4 About 

 

 

 

 

Figure 11.6  About Menu 

 

 Camera Info: Displays camera information (model name, serial number, version, etc.). 
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11.3 Tab 

11.3.1 VIEW Tab 

The VIEW tab allows you to set the camera’s region of interest (ROI), Camera Link output mode, test image 

mode, operation mode, pixel format, scan direction, TDI stage, DSNU, PRNU features, etc. 

 

 

Figure 11.7  VIEW Tab 

 

 ROI Setting: Sets the camera’s ROI by using the Offset X and Width input boxes. 

 Tap Mode: Selects a Camera Link output mode. 

 Test Image: Selects whether to apply test image and a type of test images. 

 Reverse X: Sets the Reverse X feature to On or Off. 

 Image Format Control: Sets the Operation Mode, Pixel Format, Scan Direction, TDI Stages and  

 Camera Link Pixel Clock. 

 DSNU Correction: Sets the DSNU Correction feature. 

 PRNU Correction: Sets the PRNU Correction feature. 
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11.3.2 MODE/EXP Tab 

The MODE/EXP tab allows you to configure the camera’s trigger mode, line rate, exposure time, trigger rescaler 

and trigger statistics. 

 

 

Figure 11.8  MODE/EXP Tab 

 

  Trigger Mode: Sets the trigger mode. 

  Source: Selects a source signal for triggering. 

 Activation: Selects a polarity of trigger signals. 

 Line Rate: Sets the camera’s line rate when the Operation Mode is set to TDI and the  

  Trigger Mode is set to Off. 

  Exposure Time: Sets the camera’s exposure time when the Operation Mode is set to Area  

  and the Trigger Mode is set to Off. 

 Rescaler Mode: Sets the Trigger Rescaler mode. 

 Trigger Statistics: Determines the trigger signals applied to the camera and then converted by  

  the Trigger Rescaler. 
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11.3.3 VIDEO Tab 

The VIDEO tab allows you to adjust the camera’s gain and black level settings. 

 

 

Figure 11.9  VIDEO Tab 

 

 Analog Gain: Sets an analog gain value. 

 Digital Gain: Sets a digital gain value. 

 Black Level: Sets a black level value. 
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11.3.4 STROBE Tab 

The STROBE tab allows you to set the camera’s strobe output signals or dedicated strobe controller (The Strobe 

Controller category will be activated when a dedicated strobe controller is connected.). 

 

 

Figure 11.10  STROBE Tab 

 

 Strobe Mode: Sets the Strobe Mode. 

 Strobe Inverter: Inverts the output signal. 

 Strobe Duration: Sets a duration of the pulse signal in microseconds when the Strobe Mode is  

  set to Timed. 

 Strobe Out Delay: Sets a delay to the current output signal in microseconds. 

 Rated Current: Sets a rated current of the LED light when a dedicated strobe controller is  

  connected. 

 Brightness: Sets the brightness of the LED light when a dedicated strobe controller is  

  connected. 
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11.3.5 LUT Tab 

The LUT tab allows you to download LUT data. For more information about LUT download, refer to Appendix B. 

 

 

Figure 11.11  LUT Tab 

 

 Graph: Loads LUT data from user’s computer or sets a Gamma value to be  

  applied when using a Gamma curve. 

 Camera LUT Download / Upload: Downloads LUT data stored in user’s computer to the camera  

  (Download) or uploads LUT data stored in the camera to user’s  

  computer (Upload to PC). 
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12 Troubleshooting 

When you have a problem with a Vieworks camera, please check the followings: 

 

 If no image is displayed on your computer, 

 Ensure that all cable connections are secure. 

 Ensure that the power supply is properly connected. 

 Ensure that trigger signals are applied correctly when you operate the camera with trigger signals. 

 

 If images are not clear, 

 Ensure the camera lens or glass is clean. 

 Check the lens aperture is adjusted properly. 

 

 If images are dark, 

 Ensure the camera lens is not blocked. 

 Check the line rate is set properly. 

 Check the aperture is opened properly. 

 Check the digital gain value is not set to small. 

 

 If you identify abnormal operation or overheating sign, 

 Ensure the power supply is properly connected. 

 Stop using the camera when you notice smoke or abnormal overheating. 

 

 If you have a problem using the Trigger Mode, 

 Ensure that parameter settings on your Frame Grabber are configured correctly when you operate the 

camera with CC1 trigger signals. 

 Ensure that cable connections are secure when you operate the camera with external trigger signals. 

 

 If there is a communication failure between the camera and user’s computer, 

 Ensure that the Camera Link cable connections are secure. 

 Ensure that you have configured a frame grabber in your computer and the camera is connected to the 

frame grabber correctly. 
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Appendix A Field Upgrade 

A.1 MCU 

1. Select File > System Upgrade > MCU Upgrade in the Configurator. 

 

 

 

2. Search and select the provided MCU upgrade file and click Open. 
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3. The Configurator starts downloading MCU upgrade file to the camera and downloading status is displayed 

at the bottom of the window. This process may require several minutes to complete. If you want to cancel 

the upgrade process, click Cancel. 
 

 
 

4. Once the download is complete, the saving process will begin. If a power failure occurs during the saving 

process, the camera cannot be restored. Make sure that the power connection is secure. 
 

  



 VTC-2K10.5C-C100A-80 

 Page 77 of 86 D-18-565 

5. Once all the processes are complete, turn the camera power off and turn it back on again. Select Tool > 

Terminal and enter the ‘gmv' command to confirm the version. Or select About > Camera Info to confirm 

the MCU version. 
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A.2 FPGA 

1. Select File > System Upgrade > FPGA Upgrade in the Configurator. 

 

 

 

2. Search and select the provided FPGA upgrade file and click Open. 

 

 

 

3. The subsequent processes are identical to those of MCU upgrade.  
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Appendix B LUT Download 

You can create LUT data in two different ways; by adjusting the gamma values on the gamma graph provided in 

the program and then downloading the data or by opening a CSV file (*.csv) and then downloading the data. 

 

B.1 Gamma Graph Download 

1. Set a gamma value in the LUT tab and click the Apply button. 
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2. Click the Download button to download the gamma values to the camera. 

 

 

 

3. Once the download is complete, the Download completed message will appear at the bottom of the 

window. 
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B.2 CSV File Download 

1. Create the LUT table in Microsoft Excel format as shown in the left picture below and save as a CSV file 

(*.csv). The picture in the right shows the created file opened in Notepad. Once the file has been created 

completely, change the .csv file extension to .lut. Keep in mind the following rules when creating the file. 

 Lines beginning with ‘:’ or ‘—’ are treated as notes. 

 Based on the input values, make sure to record from 0 to 4095. 

 

  
 

2. In the LUT tab, select Luminance from the Type dropdown list, and then click the Load File button. 
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3. Search and select the created LUT file and click the Open button. 

 

 

 

4. Click the Download button. After completing the download, click the OK button to close the confirmation. 
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Appendix C Correction Control 

The VTC-2K10.5C camera provides an additional feature to adjust DSNU or PRNU correction values after the 

DSNU or PRNU Correction feature is enabled. You can specify a pixel or region of the sensor and the pixel 

information from the specified portion will be adjusted according to the DSNU or PRNU coefficient value. 

The commands related to the additional DSNU Correction are as follows. 

 

Command Syntax Description 

sdt Applies the additional DSNU correction value to the specified region of the sensor. 

Xstart X coordinate of a start pixel 

Xend X coordinate of an end pixel (If you specify a pixel, you can leave this value blank.) 

Black Level 
Sets an additional DSNU coefficient value [Black Level value to be added to the 

specified region (DN, digital number)] 

Table C.1  Command related to Additional DSNU Correction 

 

 

For more details on how to save or load DSNU correction values, refer to 9.10 Dark Signal 

Non-uniformity Correction. 

 

The commands related to the additional PRNU Correction are as follows. 

 

Command Syntax Description 

spt Applies the additional PRNU correction value to the specified region of the sensor. 

Xstart X coordinate of a start pixel 

Xend X coordinate of an end pixel (If you specify a pixel, you can leave this value blank.) 

Gain 
Sets an additional PRNU coefficient value (Gain value to be multiplied to the 

specified region) 

Table C.2  Commands related to Additional PRNU Correction 

 

 

For more details on how to save or load PRNU correction values, refer to 9.11 Photo 

Response Non-uniformity Correction. 
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C.1 Adjusting and Saving Additional DSNU Correction Value 

For example, if you want to apply -2 black level from the 100th pixel to the 109th pixel, follow the procedures 

below. 

 

1. Click Tool > Terminal in the Configurator. 

2. Input the sdt 99 108 -2 command into the Terminal input box. 

3. Execute the sdd command to save the additional DSNU correction values in the camera’s Flash (non-

volatile) memory. In this case, the previous DSNU values for the current Analog Gain setting value saved in 

the memory will be overwritten. 

To ignore the adjusted DSNU correction values and load the existing values in the Flash memory, execute 

the ldd command. 

 

 

Figure C.1  Additional DSNU Correction 
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C.2 Adjusting and Saving Additional PRNU Correction Value 

For example, if you want to apply 1.1× gain from the 100th pixel to the 109th pixel, follow the procedures below. 

 

1. Click Tool > Terminal in the Configurator. 

2. Input the spt 99 108 1.1 command into the Terminal input box. 

3. Specify a location to save by using the spi 0/1/2/3/4 command and execute the spd command to save the 

additional PRNU correction values in the camera’s Flash (non-volatile) memory. The existing values in the 

Flash memory will be overwritten. 

To ignore the adjusted PRNU correction values and load the existing values in the Flash memory, specify a 

location to load from by using the spi 0/1/2/3/4 command and execute the lpd command. 

 

 

Figure C.2  Additional PRNU Correction 

 

 

Before executing the spt command, if you set the PRNU Mode to On by using the sprnu 

command, you can determine the adjusted PRNU correction values in the acquired line 

images. 
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